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Introduction 
Misterine Studio is a desktop software for authoring AR technical manuals that are published to 

the Misterine App application. AR technical manuals combine the detailing of processes of a 

technical manual with a new way of presenting the visual information related to that process using 

Augmented Reality. This method presents visual cuing overlayed onto the physical environment 

in a manner that is fully embedded into the world. An example is shown in the image below. The 

colored parts are augmentations shown virtually being inserted into the physical cone below. At 

the upper right, the same physical part as the purple part is visible. The augmentations can also 

animate to show the user explicitly each task to be performed, here inserting the fitting and affixing 

with bolts and nuts seen on either side (green and orange colors respectively).  

 
To achieve this Misterine Studio has two main interfaces that work together to allow authoring of 

the AR technical manuals. The main Misterine Studio interface facilitates the creation of the 

Process that should be performed. Both creation of Processes by hand and via import of the 

industry standard S1000D definition of the process. A progress flow graph is a basis for editing 

the process and providing all related materials, like images, reference data, etc.  

An example of a Process that is created by importing an S1000D is shown below. In the center is 

the flow of this linear process. The textual description task B(3) is shown just below it. Here a rich 

text editor is provided allowing hyperlinking and text changes. A toolbox on the right provides 

basic nodes to create and adapt flows, including branching processes via Decision Points. 

Validation of the flow is continually performed and displayed below that toolbox.  



   

 

 

 
 

Each task may have a 3D scene attached to it, which is how the augmentations are defined. There 

is a specialized interface provided for this purpose. It is similar to user interfaces used in CAD and 

3D modeling software.  

Below is an example of a 3D scene of one of the steps above. In this case four bolts on the fuel 

injector are to be secured with a lock cable. We see this in the center of the interface. A scene 

hierarchy is shown on the left-hand side showing all imported geometry. Properties of individual 

components are shown and can be edited on the right-hand side. At the bottom of the interface, we 

see interfaces for creating animations at two levels of expertise.  

 

Quick Start 
● Start Misterine Studio by double-clicking on Misterine Studio.exe 

● Create a new Project by Project → New Project 



   

 

 

o Select a folder where the project is to be placed 

o A new folder with the name of the project will be created in this location. The 

project structure will be created in that new folder. 

 

 
 

● Import an external source for the Process, via the Project → Import → Import S1000D.  

 
● During importing a dialog for missing images can show up. Images can be ignored or you 

can add them as prompted. 



   

 

 

 
● After importing, the Process will be named in the Project Explorer based on the value set 

in Preferences. This name is for your identification purposes only and can be changed. 

● Double-click on the Process in the Project Explorer to open it for editing.  

● In case of any problems, a warning will be issued next to the process name in the Process 

Explorer. Any change to the process is immediately validated.  

 
 

You can view the Validation status on a pane on the right-hand side, which is opened by 

default. If the pane is closed, you can still view the status in the lower-right corner of the 

application. 

 

Clicking on that notification will navigate you to the Process Validation dialog window 

with more detailed information about warnings and errors. 



   

 

 

 

● The Process is complete, though with no augmented content, and even so it can be deployed 

to the Server. By context (right) clicking on the Process in the Project Explorer or using 

the Process  menu and selected Deploy Process to Server you can deploy to the Server. 

 

Another option how to deploy a Process is Process → Deploy Process to Server. 



   

 

 

 

o Deployment requires authentication consisting of User name and Password. A 

dialog for entering the credentials will pop up.  

 

o Click through the deployment steps to finish the deployment. 

 

Installation 



   

 

 

Minimum Requirements 
PC with Windows 10. 16GB RAM. NVidia 1050 or equivalent graphics card. 1GB of disk space 

available. Installation of , .NET 4.8 runtime and Microsoft Visual C++ Redistributable x64 for 

Visual Studio 2015, 2017 and 2019.   

Importing from External Sources 
S1000D 
Procedural (Proced) Modules of the S1000D International specification for technical publications 

can be loaded into Misterine Studio. This will create a fully populated Process flow and fill in the 

front matter if present in the file.  

Currently, external definitions of components like equipment, spares, etc. are not supported.  

To import the file, in S1000D format, use the Import S1000D action in the Project menu.  

 

 
S1000D refers to images frequently. If those are already in the project as resources, they will 

automatically be connected to the Process. If not, you will be prompted to specify the missing 

images. It is possible to skip this during the import and connect them later. It is generally advisable 

to import all images in advance into a sub-folder of the resources section of the Project Explorer.  

 
You can import all images at one time. Simply select Import resource and then multi-select all the 

images you need. 

https://dotnet.microsoft.com/download/dotnet-framework/net48
https://support.microsoft.com/en-us/topic/the-latest-supported-visual-c-downloads-2647da03-1eea-4433-9aff-95f26a218cc0
https://support.microsoft.com/en-us/topic/the-latest-supported-visual-c-downloads-2647da03-1eea-4433-9aff-95f26a218cc0


   

 

 

 
Text 
Simple text files can be used to specify a sequential workflow of a Process. These may be pre-

existing files or can simply be leveraged for more rapid creation of simple workflow specifications, 

i.e. skipping creation of the process flow in the graphical editor.  

To import from a text file, the file must first be added as a resource. This can be achieved by using 

the Project menu and selecting Import File or by context (right) click on the Resources folder in 

the Project Explorer (or any sub-folder) and select Import Resource. After importing, context 

(right) click on the resource and select Convert to process. Change the name if required. This name 

does propagate to the official name of the Process.  

 

Licensing 
Misterine studio can work with two types of license - Studio Trial license and a Full license. While 

Studio Trial license free, the Full license is paid.  

The Studio Trial license provides a slightly limited functionality, see the table bellow.  

 

 

Functionality Studio Trial Studio full license 

Create/open processes 
  

Import S1000D 
  

Add augmentations 
  



   

 

 

Add animations 
  

Export as HTML 
  

Publish to Embedded Server 
  

Publish to External Server 
  

Refer to public resources 
  

Refer to auxiliary processes 
limited   

Manage visibility of 

processes public/protected   

Unlimited nr. of processes in 

project 
  

Unlimited nr. of processes on 

Misterine App  one only  

 

 

The instruction manuals are not limited on size, number of steps, decision points, augmentations, 

resources. The only principle difference between Studio Trial and Studio full license is its 

capability to deploy the result to a publicly (or on premise) available server. The internal embedded 

server is available on all Studio licenses.  

 

Studio licenses can be managed (activated, deactivated) in the Application menu Help → License. 
The dialog window with license overview and all possible license actions will be opened. 

 



   

 

 

 
 

Activation 
If Misterine Studio is run for the first time, Studio Trial license is automatically activated and the 

user can use Misterine Studio with a limited functionality.  

There are two ways to active the Studio - Online activation and Manual activation. In any case, 

the activation consists of entering a License ID and an activation Password. 

An already activated instance of Misterine Studio can be easily deactivated 

 

Please, do not forget to deactivate the old license before activating a new one. Only one 

license to a given instance of Studio can be active at a time. 

 

Online activation 

Online activation is a default way for activating Studio Full license. For its purpose an internet 

connection is required because a direct communication with the licensing server is done during the 

activation. For online activation, click the Activate Online button, a dialog will show up. 

 
 



   

 

 

Fill the license ID and activation password into the form. Eventually, an installation name can be 

set. The name serves as a custom note about the activation, f.e. ‘John Green computer’. After 

clicking the Activate button, Misterine Studio is automatically activated for use on this computer. 

 

Manual activation 

Manual activation is an alternative to the on-line activation for cases, where there is no internet 

connection or when the company policy does not allow for making direct connetion o the Misterine 

License Server. The activation can be started by clicking on the arrow next to the Activate online 

button.  

 

 
After selecting the Active manually, an additional dialog will show up with three steps for manual 

license activation. 

Step 1  

The first step is very similar to the online activation - license ID and activation password must be 

filled, and optionally the installation name. Instead of Activate button there is Generate activation 

request button which will generate a request for the next step. 

Step 2 

The second step is about taking generated request from the first step and providing it to someone 

who has a computer with the internet connection. The request can be sent by an email or by any 

other trusted communication tool. 

User can copy the generated request manually using standard way for copying (CTRL + C or right-

click and select Copy) or by clicking one of the prepared buttons. Button Copy to Clipboard does 

the same thing like the standard way for copying. Button Save to file offers an option for saving 

the generated request to the external file. 

The provided request has to be processed by the licensing server web page. This web page can be 

opened by clicking on Open activation page button. On this page, based on the request, the 

activation response is generated as the result. 

 
 



   

 

 

Step 3 

The third step requires a generated activation response from the previous step. The response has 

to be pasted into a prepared form.  There is a button Load from file to load a file content into the 

form for cases when  the user saved the generated response as a file. In standard way for pasting 

the user can use either button Paste from Clipboard or CTRL+V shortcut or right-click and select 

Paste from the opened context menu. 

When the third step is done, the user can click Activate button which will process the activation 

response and activate the Studio. 

The generated activation response for a license can be used only once. When the license is later 

deactivated, the reactivation will require repeating the whole activation process again. 

 
 



   

 

 

Deactivation 
Deactivation is the opposite operation for the activation. When a license is no longer used on a 

computer it can be deactivated and activated again on a different one. For this purpose, same as 

for the activation, there are two possible ways – online and manual deactivation. 

 

When the currently activated license is deactivated, Studio Trial license is automatically set instead 

and Misterine Studio functionality is limited. 

 

 

 

 

Online deactivation 

The easiest way to deactivate the license is online deactivation which requires internet connection. 

The user can do it just by clicking the Deactivate online button in the license overview dialog 

window. No additional steps are required and the activated license is automatically deactivated.  

 

Manual deactivation 

As other manual alternatives, deactivation doesn’t require the internet connection either. This 

option can be found by clicking on the arrow next to the Deactivate online button. Unlike the 

manual activation, manual deactivation is done only in two steps. 

 

 
After the click an additional dialog will show up.  

 
Step1 



   

 

 

Click the Deactivate button and the deactivation request is automatically generated when the dialog 

is opened. In order to finish with the license deactivation, you must send the data provided in this 

step from a computer with internet connection. To do so, transfer the request (text) either via email 

or as a file to another computer send then send it from there. You can use the standard way for 

copying (CTRL + C or right-click and select Copy), eventually by clicking the Copy to clipboard 

button which does the same, or click Save to file button that saves the request to the external file. 

In order to move to the next step, the deactivation response must be generated on the licensing 

server web page.  

This web page can be opened by clicking on the Open deactivation page button, once the computer 

is connected to the internet. 

Step2 

Finish the deactivation by pasting the server response into the Step 2 section of the form. The 

deactivation code can be in a form of a file or in a form of plain-text pasted from clipboard. For 

loading the external file click Load from file button to load a file content into the form.  

Click the Activate button to finally deactivate the license. 

The generated deactivation response can be used only once. For any other deactivation a new 

response has to be generated when deactivating manually. 

 

Refresh 
In order to keep the activated license active, it is necessary to refresh the license regularly. The 

refresh operation is fundamental and in standard situations it is done automatically. However, there 

are situations when the automatic refresh is not possible. It can be caused for example by 

restrictions of networking or simply by a lack of the internet connection. 

 

If the license is not refreshed within 90 days since the last refresh, it starts acting like the Studio 

Trial license. License refresh expiration is automatically announced 10 days before the license is 

invalidated. 

The refresh of the license can be performed in these ways: 

1. Automatically when Studio is opened.  

2. Online upon request 

3. Manually upon request  

 

 
 

Online refresh 

For computers with access to the internet, the online refresh must be enforced only if the license 

parameters were changed. With the internet connection the automatic refresh should work properly 

being triggered when Studio is started. 

 

Manual refresh 



   

 

 

With restricted or no internet connection, manual refresh is the only option to refresh a valid 

license. It works in the same manner as manual deactivation, please refer to the manual 

deactivation process.  

 

Expiration 
The Studio full license is a time-limited license. It will expire after 365 days from the date of 

purchase. After this period, it is necessary to renew the license in order to have full access to all 

Misterine Studio features again.   

 

If the license is expired or not renewed, the Stuido will act as if having Studio Trial license. Before 

this should happen, a license expiration warning is shown 30 days before the actual license 

expiration. 

 

 
 

You can check date of expiration and number of days until the license expires in the license 

overview dialog. 

 

  



   

 

 

Creating and Managing Projects 
A Project is a data structure containing Processes, Resources, and Templates. To create a project, 

click Project → New Project in the application menu and follow the instructions in the wizard 

dialog. Every project will create a physical folder on the disk named after the Project name. This 

folder will contain the project file (with .vip extension) as well as other project files. Instruction 

manuals, processes and other resources of a project stay on the computer until one or multiple 

processes are published to a server. Even then only the relevant files are encoded and transferred 

to the server, the rest is never published nor transferred anywhere.  

 

Adding Processes 
To add a new empty Process, click Process → Create New Empty Process in the application 

menu or right-click the Processes folder in the Project Explorer and choose Create New Process; 

 

Processes are explained in the section Creating and Editing a Process Flow. 

 

Adding Scene Templates 
To add a new Scene Template, right-click the Scene Templates folder and choose Create New 

Scene Template. 

 

Scene Templates are explained in the section Scene Templates. 

 

Adding Resources 
To add resources, click Project → Import in the application menu and choose the type of file to 

import. Resources may also be imported by right-clicking the Resources folder and choosing the 

appropriate option. 

 

Resources are explained in the section Resources. 

 

Creating and Editing a Process Flow 
The main visual focal point of the main Misterine Studio application is the Process Flow (diagram) 

Editor. It is outlined in red below. This is the definition of the Process, also known as procedure, 

that the user will do in the Misterine App.  



   

 

 

 
The Process is displayed and defined by a graph flow. The arrows of the graph define the order of 

tasks that the user should perform.  

The elementary unit of work the user should do is called a Task (also known as a step). A 

sequenced of Tasks and other nodes in the graph define the instruction manual flow. Besides Tasks, 

there are other types of nodes in the graph, namely:  

 

Flow Nodes 

 Start Event  

Start nodes indicate where a Process starts. A process must have exactly one Start Event node. 

Start Event nodes also exist in Sub-Processes, but outside of Sub-Processes there may be just one. 

Other than the logical beginning of the process, the Start Event node has no other practival 

visualization. 

 

 End Event    

End Even node indicates the end of the Process. It is a logical node for the purposes of indicating 

the end and it has no other practical visualization. End nodes exist also in Sub-Processes, described 

below.  

 Presentation Task 

Presentation Tasks are the fundamental work that the Misterine App user does. These are often 

called steps for a procedure.  

 Sub-Process 



   

 

 

Sub-Process is a logical separator in a Process. Typically, it is used to hold a complex task that is 

logically one thing, but requires the user to perform multiple individual tasks. Sub-Processes can 

be embedded up to 8 levels. A Sub-Process must always contain a Start, End and at least one 

Presentation Task. 

 Decision Point 

Decision Points are places where different sets of Presentation Tasks could be required based on 

some choice. This is a single input node with at least two outgoing directions (1:N). In the current 

implementation, there is only one way to "resolve" the decision, a Simple Form, which is just a 

question with multiple answers that the user themselves decide. These will be described more 

below. 

 Connection Point 

Connection Points are logical blocks that collect multiple input streams into a single outward 

direction (N:1). They are used in conjunction with Decision Points. The Misterine App user will 

not directly experience these nodes. 

 

Toolbox 
All of these flow nodes can be added to a Process Flow graph by hand. On the right-hand side of 

the application is a pane called Toolbox. It is opened by default, but can be unpinned (closed).  

Nodes can be added to a Process Flow by two methods. You can drag’n drop any node into the 

Process Flow Editor. This will place a single node. If you need to place multiple of the same node, 

e.g. a Presentation task, you can click the node type in the Toolbox. Each click onto the editor will 

place a node. This continues until you press the ESC key or click right mouse button. 

Nodes can be placed on the Process canvas or also into Sub-Processes on the canvas.  



   

 

 

 
Flow Node details 
When a Presentation Task, Sub-Process or Decision Point is selected in the graph, the details of it 

will appear in the panel below the graph. Here you can specify the content that will be presented 

to the Misterine App user.  

 

Presentation Task and Sub-Process details 

Title and Description: This is the text information presented for them to be able to complete the 

flow node. This is frequently the exact task that exists in a traditional manual.  

Warnings and Cautions: These are Safety notifications that are displayed to the user before they 

can perform the action of this task. Warnings are displayed with a red box and require explicit 

confirmation. Cautions are displayed with a yellow box and can be dismissed more easily.  



   

 

 

 
Decision Point details 

Title: The title of the Decision Point is most visible when viewing the overview of the Process in 

the Misterine App.  

Outputs: Outputs are the directions you can go after making a choice. They are named to assist 

with connecting the Resolution Method (see below) and connecting the graph. These names are 

only used in Misterine Studio and not visible to the Misterine App user.  

Resolution Method: This is the way that this decision will be made. Currently, Misterine Studio 

has a single resolution method, a Simple Form. This is a simple question and multiple-choice 

answer for the user. Each choice leads to one of the Outputs.  

The question is simple text. Options consist of a Description, which is simple text that is presented 

to the Misterine App user, and an Output. 

To be valid, all outputs must have at least one resolution option that triggers that output. All fields 

must be non-empty. 

 

 

Scene Templates 
Scene Templates are 3D augmentation scenes without relations to any processes or tasks. 

Instead, these templates serve as a base for any future scenes created on the tasks in a given 

project. 

 



   

 

 

Scene Templates can be edited as any other scenes. Open the Scene Designer by double-clicking 

the item in Project Explorer or by bringing up the context menu and choosing the Open option. 

 

Many Scene Templates can exist in the project but only one can be set as the default template. 

By default any new scene created in a presentation task will create a copy of this default 

template. This behavior may be changed in Preferences. 

 

To create a new scene with a template as a base, select the task, right-click the base template and 

choose Add to Selected Task in the context menu. Another option is to drag and drop the 

template onto the task itself. 

 
 

It is also possible to create a template from an existing scene attached to an existing task. Just 

right-click the task with the scene attached and choose Make Template Scene in the context 

menu. 

 
 

Resources 
Misterine Studio keeps track of two kinds of resources, source files and true resources. For large 

projects, it is possible to organize the project resources by creating and using folders. 

Source files include S1000D XML files and TXT files (see Importing from External Sources 

above). You can trigger the (re)import of these files by context (right) clicking on the resource and 

selecting Convert to process. 

True resources include: 

● Image files (JPG, PNG, BMP) 

● PDF files 

These true resources can be: 

● Renamed 



   

 

 

● Previewed 

● Access rights can be set. Currently, this is limited to shareability settings that affect only 

the resource when deployed in a Process to the Misterine App. It is primarily useful with 

original PDF manuals.  

Preview option 

Misterine Studio shows the common information about resources and processes that are included 

into a project. Previews can be shown for processes, images, XML files, PDF files and TXT files. 

You can see the Preview Panel under the Project Explorer panel. If nothing is selected or selected 

an item that cannot be previewed the Panel shows the message ‘No other details. Select single item 

for preview’. 

Process preview appears if any process is selected. The process preview contains common 

information about process. Also a user can navigate to the original PDF resource file or to the 

source file from which the process was created (it can be TXT file or S1000D). 

Process preview contains the information about deployments to remote servers. This table contains 

date and time of deployments, QR code which can be saved, and link that can be copied to the 

clipboard. 

  

Image preview appears if any image is selected. The image preview contains a small 

representation of image itself and the information about image parameters: dimensions, format and 



   

 

 

size in MB. If an image is used somewhere in processes the table ‘Connected Processes’ appears. 

User can navigate to a process where the image was used. 

  

PDF Preview appears if any PDF file was selected. The PDF Preview contains the information 

about a file: format, size in MB and access rights. A user can set the shareable property from the 

Preview. If a PDF file was used somewhere in other processes the table ‘Connected processes’ 

appears. User can navigate to a process where the PDF file was used. 

  

TXT file Preview and XML file Preview contains only the information about connected 

processes. User can navigate to a process where the TXT or XML file was used. 



   

 

 

  

Adding Augmentations 
Misterine Studio uses a layer concept that is fundamental to how our system works. This system 

is used in many design tools, include 3D modeling software, so it is likely to be familiar to the 

user. Our design is slightly different as there is more of a relationship than in most software. How 

to deal with layers in Misterine Studio is described below in a section Dealing with Layers. 

There are fundamentally three different components that the user needs to specify for the AR scene. 

1. The physical scene - the parts of a model that will be physically present during the 

Presentation Task in the Process. We call this the Background.  

2. Tracking - the purpose of tracking is to create an understanding of the physical environment 

and our relationship to it. It is a necessary step for being able to locate augmentations. 

a. Tracking methods are based on external objects called AR Positioners (i.e., Fiducial 

Markers or Interactive Anchors). For this, the AR Positioner needs to be situated to 

the background in the same place it would be in the real world. 
b.  

3. The augmentations. This is the actual AR components of the scene. This may be parts of 

the model and even things that are part of the Background / Tracking. It could also be other 

models, like a tool. Augmentations could also be animated. 

a. We differentiate augmentations into two, those that are automatically shown and 

those that are optional. The automatically shown we term as part of the Foreground. 

The optional we denote as part of the Context. 

Adding Scene 
To start adding augmentations, it is necessary to add a Scene that serves as a container for all 

augmentations. The Scene can be added only to Presentation Task using button  or using an 

option Add 3D scene in its context menu. 

 

 
 

Dealing with Models 



   

 

 

Misterine Studio currently supports 3D models in triangle soup format with per face group 

coloring.  

Importing 

CAD and 3D models can be imported via the button  or by drag’n’drop onto the Scene Explorer 

component 

 
 

 

 

Supported formats: 

● CAD formats: STEP, DXF 

● common 3D graphics formats* (3d, .3ds, .3mf, .ac, .ac3d, .acc, .amf, .ase, .ask, .assbin, 

.b3d, .blend, .bvh, .cob, .csm, .dae, .dxf, .enff, .fbx, .glb, .gltf, .hmp, .ifc, .ifczip, .irr, 

.irrmesh, .lwo, .lws, .lxo, .md2, .md3, .md5anim, .md5camera, .md5mesh, .mdc, .mdl, 

.mesh, .mesh.xml, .mot, .ms3d, .ndo, .nff, .obj, .off, .ogex, .pk3, .ply, .pmx, .prj, .q3o, .q3s, 

.raw, .scn, .sib, .smd, .stl, .ter, .uc, .vta, .x, .x3d, .x3db, .xgl, .xml, .zgl) 

*graphics formats that support animations only import the geometry and materials (including 

textured). 
Scene settings 

The scene settings can be changed in the Preferences dialog under Edit → Preferences → Scene. 
The form contains the following sections. 

 



   

 

 

 
Model import – General 

This section contains the general settings relevant for all supported types of models and includes 

the following inputs: 

 

● Move imported model to the Foreground layer - When checked, all nodes from the 

imported model scene graph are automatically included in the Foreground layer. 

● Chain animations if there are multiple animations attached to the same node - If there are 

multiple animations attached to the same node you have option to chain them. Chaining 

means that the next animation will start playing on a timeline after the previous one and 

so on. When the animations are not chained they will start at 0 and only the first one will 

be played since you can only apply one keyframe animation at a time.  

● Default material - Allows a user to change properties (color, shader type) of the default 

material. The default material is applied to geometry when no material is attached in the 

imported model. 
Model import – 3D model formats 

This section contains the settings relevant to the import of 3D model formats and includes the 

following inputs: 

 

● Attempt to fix in-facing normals - When checked, the imported process searches the 

model for meshes that have normal vectors facing inwards and inverts those normals. 

This is done by comparing the bounding box of all vertices and their normals with the 

bounding box volume of the same vertices without their normals. 

 



   

 

 

● Attempt to unify identical meshes - When checked, the imported model is searched for 

duplicated meshes; Duplicates are replaced with a reference to the first mesh. This 

improves App performance and decreases the size of deployed Processes. 

 

● Split large meshes - When checked, large meshes are split into smaller sub-meshes. Most 

of the time this should be activated as it can lead to performance improvements and 

increase your scene compatible with lower end devices. If you intend on using the Studio 

decimation function you may need to deactivate this functionality.  

 
Timeline configuration 

● Show non-animatable objects – By default all selected objects are shown in the Timeline. 

For interactive anchor no animation can be created and a row with this information will 

be shown in the Timeline window. To hide these objects, toggle this checkbox. 

Model units 

3D models may contain units in which the corresponding model was designed. If available, this 

information is extracted from a model during the import. The default units are used otherwise 

based on the format of the imported model. 

Since augmentations make sense only at a reasonable scale, the model bounding box size is 

checked immediately after the model import. The user is warned using the following dialog if the 

bounding box size exceeds the minimum or maximum limit of 0.1 m or 10 m, respectively. 

 
The dialog displays the original units extracted from the imported together with its bounding box 

size. The size that exceeds the minimum or maximum limits is highlighted in a different color. 

The dialog provides the user with an option to select different units and preview the bounding box 

size in the selected units. Units can be changed using the drop-down menu as depicted in the 

following figure. 



   

 

 

The units in the list are distinguished by a highlight if the model bounding box exceeds the limits. 

This can help the user to quickly determine which units are probably the best fit.  

After the proper units are confirmed, the model is imported to a 3D scene scaled based on the 

selected units. This check is done only during the import of the model. The imported model is 

added to the list of model assets and this check is not performed when this asset is added to a 3D 

scene. 

 
Tessellation 

When importing parametric CAD formats, namely STEP, a process called Tessellation must be 

performed.  

 



   

 

 

The meshing algorithm provides two options to define triangulation – linear and angular 

deflections. In the first step, all edges from a face are discretized according to the specified 

parameters. In the second step, the faces are tessellated. 
Linear deflection 

 
Linear deflection limits the distance between a curve and its tessellation. Angular deflection is 

relatively simple and allows using a default value (12 - 20 degrees). The angular deflection is 

specified in radians.  

 
Angular deflection 

Angular deflection limits the angle between subsequent segments in a poly-line. Note that if a 

given value of linear deflection is less than shape tolerance then the algorithm will skip this value 

and will take into account the shape tolerance. Linear deflection has an absolute meaning and the 

application should provide the correct value for its models. The range of the input values is (0, Inf) 

for absolute, and (0, 1] for relative deflection. 

The user should provide deflection parameters to compute a satisfactory mesh. Giving small values 

may result in a too huge mesh (consuming a lot of memory, which results in a long computation 

time and slow rendering) while big values result in an ugly mesh. 

Decimating Models 
Frequently models may be too high of a resolution, meaning they have too many triangles. Ideally, 

we want fewer than one million triangles in a scene. Misterine Studio provides a Decimation 

functionality to reduce the size of the model.  button opens the decimation dialog.  



   

 

 

 
Target Percentage: this is a percent value that indicates what size you want the model reduced 

to. In the example above we are targeting 75% of the original size. The value can be adjusted by 

dragging the slider. 

Preserve borders: Man-made objects often consist of hard edges (cylinder is a perfect example). 

Preserving borders attempts to find such edges and "fix" them to prevent decimation from 

removing them. This can prevent the algorithm from reaching the desired size. 

Repair mesh: Applies algorithms to fill holes, merge vertices, stitch edges, and many others in an 

attempt to automatically "repair" an input mesh, where "repaired" means the mesh is closed and 

manifold. When the mesh is manifold decimation can provide better results as it works with the 

mesh as a whole and does not create holes. 

Compute normals: forces the replacement of the normals on the faces to new ones calculated on 

the reduced faces.  

The information panel on the bottom left provides information on how effective the current settings 

are and the preview updates to show the appearance with these settings. 

Reusing Models 
Any model that has been imported is available as an asset in the Asset Explorer tab. In the image 

below, we see Assets that are Tools that are 3D models of common tools. Below that is the Models 

section, which are those models already imported somewhere in the Project.  

Re-importing will cause the model to be duplicated which will increase the size of the deployed 

Process. By using the asset when starting again from a blank scene, the same model resources will 

be used. This saves space in deployment and also will lead to less delays when moving between 

scenes. 

Additional sections here are Clips and Animations which are explained in the Creating and using 

Animation and Clip Assets section below.  



   

 

 

 
 

Changing Appearance (Materials) 
Misterine Studio currently supports only changes to material appearance and color. For augmented 

situations, this is usually sufficient as such renderings work best for highlight parts. When a mesh 

is selected (a cube icon in the Scene Explorer), the material assigned to it is shown in the properties. 

In the Property Editor the  button will cause the material to be highlighted in the Material 

Explorer. This is important as the material may be shared by multiple meshes/surfaces. Any 

modification performed in the Property Editor will prompt the user to either change all or only 

local if the material is shared.  

Material Explorer is a tab where the Scene Explorer is found. Here all materials in the scene are 

shown. Modifying them here causes all meshes with the material to update. The  button next 

to the color selector adds all meshes with this material to the current selection set. The  icon 

on the right updates all selected meshes to have that material. Unused Materials are shown at the 

bottom and you can create a new material in this space in preparation for applying it to models. 



   

 

 

 
Materials can be one of three types: 

● Default - general purpose shading for catching the attention of the user 

● Plastic - a semi-shiny shading similar to many hard plastics 

● Metal - a shiny shading similar in effect to a metallic surface 

Colors can be freely specified, including transparency.  

 
Some 3D model formats support textured materials. If there’s texture attached to a material, it is 

imported with the model and a corresponding thumbnail is displayed. 



   

 

 

  
The import of the following texture maps is supported: 

● Diffuse map 

● Normal map 

● Specular map 

A thumbnail of each supported texture map can be seen in a drop-down menu (if available) as 

depicted in the following figure. 



   

 

 

 
The texture map can be previewed in a separate window by clicking on the corresponding 

thumbnail in a drop-down menu. 

Textured materials cannot be re-assigned to other objects in a 3D scene. 

 

Specifying Scene Position in the Real World (also known as Tracking) 
The following scene registration methods are supported. 

● Tracking Markers 

● Interactive Anchors 

AR Positioners can be positioned the same way as any other object in a scene. You can also use 

the special Position Tracking marker mode which is enabled by clicking the  button or by 

pressing T. This mode snaps the AR Positioner onto any face of the model under the pointer. When 

the AR Positioner snaps to a face, it also orients flush to the face. The up direction is determined 

by the viewport, i.e., the camera view you look at it. 



   

 

 

  

Every scene requires at least one AR Positioner to be present. More registration methods can be 

used together in one scene at the same time. 

Tracking Markers 

Tracking Markers (also known as Fiducial Markers) serve to achieve proper positioning of 

augmentations in the context of the physical environment. This method involves locating a 

Tracking Marker in a scene to a desired relative position to the augmented object. 

 button adds a Tracking Marker to the scene. Markers are uniquely identified by a combination 

of format - the number of squares used in the design - and an ID. Only one marker of the same 

format and ID combination can only be present in a scene, and best practice would be to have that 

marker always in the same position/orientation for the entire Process. Mixing different physical 

sizes in a single Process is not supported by the Misterine App. 

 

The Tracking Marker should be printed and placed in the physical environment at the same relative 

position to the augmented object as its virtual counterpart. The physical counterpart is registered 

by Misterine App using a device camera which enables displaying the augmentations at the proper 

location. How to export Tracking Markers for printing is described in section Export of Tracking 

Markers to PDF. 



   

 

 

 

Interactive Anchors 

Sometimes it is more appropriate to simply let the user roughly position the scene into their 

physical environment via an interactive process. In this process they see flat spaces mapped and 

can simply indicate where to place the scene by ‘touch’. This does not provide precise positioning 

of augmentations. Unlike Tracking Markers, there’s no need for printing and locating any markers 

in the physical environment.  

 button adds an Interactive Anchor to the scene. Only one Interactive Anchor can be used per 

scene. 



   

 

 

 

 



   

 

 

The augmentations are located relative to that selected point. The position of augmentations can 

be later adjusted manually. 

 

Inserting Labels 
Labels are text elements that are placed into the scene in 3D space.  

 
 



   

 

 

They consist of a label that is typically floating in space and a line going to an object. or space 

where an object would be. When pressing the button  to create a label, a popup will request the 

label text. This can be modified later in the Property Editor. 

Labels are always attached to an object or hierarchy node. The text will automatically be 

prepopulated with the name of the scene graph node it is attached to.  

For placement of the arrow to the underlying object, Misterine Studio supplies an assistance tool 

 (or press Y) that snaps the line onto the mesh faces of the object(s).  

 

Inserting Notes 
Notes are documents that can contain text and other multimedia while being placed in the 3D 

scene. To add a Note to the scene, click the icon in the designer toolbar or press the 

associated key shortcut (A3) Keyboard Shortcuts). 

 

Note editor is explained in section Note Editor. 

 

Manipulating Models 
Manipulations of models occur via a gismo that appears in the 3D view. The standard QWER 

mapping is used for shortcuts to access them. They are also available via the buttons: 

 
 

Gizmos can work in a local coordinate system of a specific model part, or in a world coordinate 

system, which is common for all model parts in a scene. The currently used coordinate system can 

be changed using a switch in a scene toolbar menu. You can also set if origin of following 

transformation is set to a pivot of a transformed model part or to its center. 

 

 
 

Images below show some differences in a usage of various settings. 

 

Local (left) vs. World (right) with the center as the origin 

Origin is set to the center position of the model but since there is a local transformation applied to 

it, the local coordinate system is also rotated. On the other hand, world coordinate system ignores 

this local change. You can easily compare the coordinate system of the gizmo with the axes in 

bottom left corner; if they are the same you are using world coordinates. 

 



   

 

 

 
Local (left) vs. World (right) with the pivot as the origin 

Almost same effect as the previous image shows, but with a transition of the origin to the pivot 

position. The position of pivot depends on how the hierarchy of the object is structured. The pivot 

corresponds to the origin of the transformation coordinate system. In this case, the cube was 

modeled in such a way, that the origin didn’t lie inside of the cube (as is commonly done) but had 

an offset, i.e. where the gizmo’s center is. 

 

 
 

 

Local vs. World without transformation 

If there isn’t any local transformation applied to the model then the Local and World coordinate 

system are the same. 

 

Except using gizmos for doing transformations, transformations values can also be manually 

changed in the Property Editor. The rotation is represented in Euler angles and degrees. It is 

important to remember, that these properties show the state of the object – that is they display the 

local transformation values. 

When the value is too small or too large to fit in the text field, it will be replaced using scientific 

notation. 



   

 

 

 
Changing View 
RMB + Drag: rotate the camera around the center point (red dot) 

MMB + Drag: translate the camera along the view plane 

Mouse wheel: zoom 

The  button and the F key shortcut center the view onto the selected object and zoom to fit it. 

If no object is selected and F key is pushed, the visible scene is centered and the camera zoomed 

to fit. 

The dropdown seen below allows setting the viewport to standard views along the fundamental 

axes, with the current selection centered and zoomed. 

The dropdown seen below allows setting the viewport to standard views along the fundamental 

axes, with the current selection centered and zoomed. 

 
 

Multi-View Layout (4:1 viewport) 

Multi-view layout can be activated and deactivated either by pressing the  /  button or by 

using the CTRL + Space shortcut. By activating this feature, the viewport is split into four 

independent viewports displaying the same scene. These viewports can then be arbitrarily moved 

or rotated to enable different viewing angles. The position of camera is stored per each view. 

 



   

 

 

 
 

Scene Statistics 
Basic information about the scene complexity is displayed in the status bar, located in the bottom 

right corner. 

 

 
 

The status bar contains information about the total triangle count in the whole scene and the 

number of triangles in currently selected objects. It also displays the number of materials 

currently used in the scene. By clicking this section, the user can view more detailed information 

about the scene. 

 



   

 

 

 
 

This window contains complex statistics about the whole scene, its foreground layer, and about 

the objects currently in selection. Each section provides a breakdown of all the objects belonging 

to it with information such as the number of triangles, size of the bounding box, number of 

materials and its size, and more. The window is non-modal and you can continue working while 

keeping the statistics page open. The idea behind this dialog window is to allow the user to 

optimize their scenes for more seamless deployment and visualization. 

 

Dealing with Layers 



   

 

 

There are four layers (Background, Foreground, Tracking, Context) in Misterine Studio and each 

of them has a specific purpose. 

Defining the Background is fairly straight forward. The user can add 3D models to the scene. The 

models will appear. They will then be able to hide elements of the model to simplify working with 

a specific part of the model. All the other parts would be hidden. This can happen within the 

hierarchy of the LSG simplifying the process. It can be done in a tree view explorer module or via 

the 3D interface. Multiple models can be added to Background. 

Tracking marker(s) would be added to the scene in the Tracking layer. The marker would be 

positioned in its spatial position via standard manipulations. There are also tools like snap to face 

to facilitate the placement. 

Tracking hint tools will be added from the toolbox directly into the Tracking layer and can only 

exist there. They are there to transmit a priori information to the system so it can optimize the 

computer vision methods. 

The Foreground and Context layers both function the same at the moment. This will change in the 

future, where the context layer will be any augmentations that can optionally be shown. The user 

can add models, for instance tools used in the Presentation Task, to the scene. They can also show 

portions of the model that were hidden in the Background, for instance in an assembly procedure 

this would be necessary. They can then position it as needed. A special key-frame animation 

module will allow objects in these layers to be animated at the node level only. For the animation 

module we will follow the typical UI designs. 

Changing Visible Layers in Viewport 
On the right side of the top bar of icons are all the layers. 

 
These control which layers are visible in the rendered viewport. In the example to the right, all 

layers are currently shown in the viewport. In this next example, only the Tracking (T) and 

Foreground (F) layers are visible. 

 
Changing Layer of Objects 
Model objects and individual sub-parts of those models can be assigned to any of the layers via 

the same icons in the Property Editor. Models can be in all layers, though presence in Tracking 

currently does not have any effect. 

Labels can only be placed into the Context and Foreground layers (currently no effective difference 

on deployment).  

Tracking Markers can only be found in the Tracking layer. 

 



   

 

 

Animating Models 
The interface has two main components, the Timeline and the Animator. Each window has its own 

timeline (if displayed for keyframe animation). It is important to differentiate between 

1. Timeline current time – Marked with grey line and is shown in keyframe Animator as well. 

It shows the time that will be used to sample the animation. 

 
2. Animator current time – Marked with red line and corresponds to current time used to 

create keyframes. Red color is associated with keyframes or the process itself (red outline 

for viewports when keyframing, animated properties have reddish color, keyframe clip is 

also red). 

 
3. Current clip time – Each clip consists of keyframes and additional properties like stretch. 

These properties affect how the clip will be sampled. The grey line in keyframe Animator 

correspond to the clip time. Clip time is nothing else then projection of the timeline current 

time. 

4. The times are not synchronized but it can be toggled by checking the “sync” button next to 

the current time in the Animator. When toggled, the time that is set in the Timeline will be 

also set in the Animator. 

 

Creating an animation - Basics 
1. Select an object (or hierarchy node) 

2. Click the  button in the middle of the timeline. 

3. This adds a track to the object and creates a fly-out animation 

4. The clip is automatically selected and therefore ready to edit 

5. The clip length can be changed by dragging on the ends of the purple clip in the timeline. 

The clip does not have to be selected for this to work. 



   

 

 

 

Using the Timeline 
The Timeline is intended to permit users without extensive experience the ability to create at least 

minimal animations. The basis for the Timeline is clips. Clips in the Timeline are an encapsulation 

of a keyframed animation. They may be strictly the same, but they may be more. 

We differentiate between two clips – one is colored red and the other blue. Blue clips are backed 

by a generator (some mathematical representation of a certain action – fly-out, rotate etc.) and red 

clips are keyframed. 

Moving clips 

Clips can be moved in the Timeline simply by dragging them left and right. This changes the 

relative timing to the start of the (tracked) scene. Dragging the clip (or it’s end points) can be 

constrained to snap to endpoints when holding Shift. You can also move a clip to the current time 

using its context menu. 

It is possible to move clips between tracks while holding Alt and the clip. If you have more than 

one clip in the track you can move the whole track using the arrows next to the name of the track. 

Alternatively, you can just reorganize the tracks by dragging the track (hold and drag the track 

header).  

 
If you move a clip (or create one over already existing one) you can easily end up with multiple 

clips at the same time which can result in undefined (and definitely unexpected) behavior. Check 

for overlaps highlighted in yellow/black stripes. 

Keyframed clips 
As the name suggests, these clips consist of keyframes. Each keyframe is a pair of value and 

timestamp. When selected, the clip is shown in the Animator with default view showing the 

properties. The keyframe represents the local state in time. 

Keyframe Properties 

A keyframe clip may be designed at a certain length. For instance, our keyframer only allows 

360deg of rotation. There are various conditions, such as this where the base clip defines a unit of 

animation, but the desired effect is greater. To those ends, you can change the length of the clip 

and change the behavior.  Each keyframed clip provides some additional properties that can be 

tweaked. 

1. Stretch just takes the keyframes and maps them so that first keyframe is at time 0 and the 

last keyframe is at the end of the clip. 



   

 

 

2. Reverse inverts the time used for sampling effectively changing the direction of animation. 

3. If you want to repeat the above-mentioned rotation, you can toggle Repeat. You can specify 

the number of repetitions where 1 means no repetition. If you want to create the effect of 

moving forward and back, you can toggle Mirror. 

4. (Advanced user) If you import an animation (or restore from an asset) you can have 

different axis. To solve this, you can change the up/right axis. The last (forward axis is 

computed from these to create right-handed coordinate system). 

5. When nothing is toggled the values are sampled in the clip range and the keyframe’s time 

corresponds to global time by simple addition of clip start time. Note that when the clip 

starts with an offseted position and not in time 0, there will be visible jump to the position 

in clip. 

 

 
  



   

 

 

Editing keyframes 

You can edit (create) the keyframes when you go to edit mode using the “Edit” button. When you 

are in edit mode, red outline around viewports is displayed and any change in property editor or a 

change using gizmos will be stored as a keyframe. The properties affected by keyframes are 

position, rotation, scale, and visibility. 

You can delete and move the keyframes. When the keyframes overlap, they are highlighted by red 

color. This might not necessarily be wrong but it can inform you about 2 keyframes inserted at the 

same time (this overlap is an issue, not when zoomed out). 

 
More information about keyframing can be found in its own section. 

Reusing Animations 

Clips can be reused in two ways. The first is using copy and paste to duplicate them. The second 

is by creating a ‘named’ asset, which can then be reapplied. 

Copy and paste works as would be expected. With a clip selected simply copy it (CTRL + C). 

Then select a track where you want to place it, but moving the cursor over that track. The track 

can be the same track, a different track or a track in a different object. You can have both objects 

selected and see the tracks, or you can change selection or even scenes before pasting. 

If the clip is particularly interesting or going to be frequently used, it can be helpful to make it into 

an Asset. If you context (right) click on the clip you have an option to Save Asset Clip. This will 

create an asset that will be available in the clips section of the Asset Explorer. From there you can 

add it to tracks or objects as required. 

Creating and using Animation and Clip Assets 

Animation clips and whole animations can be saved as assets for later use. 

  



   

 

 

Clip Assets 

Clips can be saved by right-clicking on the corresponding clip and selecting the Save clip as Asset 

context menu option. The user is then asked to enter the name of the clip asset. The name of every 

clip asset should be unique. 

 
The saved clip asset can be found in the Asset Explorer tab under Clips. 

 
There are two ways to apply clip assets to selected objects in a scene. 

● By dragging the clip asset and dropping in the Timeline pane - the clip starts at the point 

in the time where it was dropped; 

● By right-clicking on the clip asset and selecting the Add to timeline context menu option - 

the clip starts at the current time; 

If there’s no animation defined for the selected object, it is automatically created. The clip is added 

to the first empty track. If there’s no empty track in the animation (or no track at all), a new track 

is automatically added to the end of the tracks (the order can be changed manually). 

The clip assets can be removed by selecting the asset in the Asset Explorer and pressing DELETE 

key or using or by right-clicking and selecting the Delete context menu option. 
Animation Assets  

Animation can be saved by right-clicking on the corresponding clip and selecting the Save 

animation as Asset context menu option. The user is then asked to enter the name of the animation 

asset. The name of every animation asset should be unique. 



   

 

 

 
The saved animation asset can be found in the Asset Explorer tab under Animations. 

The animation asset can be applied to the selected objects the same way as clip assets. The only 

difference is that animation clips are always added to the Timeline origin. 

If one or more of the selected objects already contain animations, the user has two options: 

● Replace all - all existing animations in the selection are replaced by the applied animation 

asset. 

● Merge all - the existing animations are preserved, the tracks from the applied animation 

asset are added at the end of each animation. 

The animation assets can be removed by selecting the asset in the Asset Explorer and pressing 

DELETE key or using or by right-clicking and selecting the Delete context menu option. 

Generators 
We identified common usages for animation. For these, we have created generators accessible 

through track context menus. Generator is a function that affects a property or even the whole 

transform (rotate around center). 

We group these according to properties they can affect. Properties that can be affected are position, 

rotation, scale, and color. Some generators affect multiple properties like the Screw in that rotates 

the object and also moves it. The generators can be combined (in the same time or chaining). When 

two generators overlap their affected properties are checked and the topmost is used (but this can 

be unpredictable and such usage is discouraged). If the don’t affect the same property you can use 

it to create different animations since these generators represent transformations applied top-down 

and for combining transform the order matters. For example, if rotation is first (top most track) 

and translation is below, then it would be the same as changing the node transformation in property 

editor (setting rotation and translation). However, if you swap these, then rotation will be applied 

first and the translation would be done on top of this rotated state. 

Generally, you should remember that the generator animates from the current state and the original 

state is in the bottom left corner of the Timeline. 



   

 

 

 
Color generators 

If the object has a material assigned, you can also create 4 different color animations – color 

transition, fade in and out, pulse.  

 
1. Color transitions interpolates between two colors and provides 4 different color 

interpolation types. RGB interpolates in RGB color space, HSL in HSL etc. Each of these 

spaces has some difference. RGB can be imagined as a color interpolation in a cube, HSL 

interpolates color hue on a circle and the rest are more complex spaces that try to preserve 

lightness of the color. If you don’t see much difference (and there might be none) RGB is 

a good default. 

2. Fade in/out animate the transparency of the object. 

3. Pulse is similar to fading, but it is repeated multiple times. 

 



   

 

 

 
When color is animated, it changes directly the color of a material. Material can be however used 

by multiple objects, so the color of all these objects will be changed (this might be wanted and if 

not, just create new material).  

Keyframing 
Traditional keyframing can be performed while the clip is active in the Animator. This state is 

indicated by a red framing to the 3D view. 

Keyframe Animator underwent some changes from last release. The timeline in Animator is no 

longer based on frames. 

 
Animator now displays the current time in the clip (0.1876) that is marked with red vertical line. 

The orange vertical line now shows how is the current Timeline time converted to the clip time. 

By toggling the synchronization (next to the time), moving the time in Timeline will set the time 

in the Animator. Decoupling the times allows to make it easier for changing the animation pace.  

Imagine the case where you create an animation moving object from one place to other. By 

default, it’s a linear interpolation and the speed is constant. Now you might want the object to be 

halfway sooner. It is simple to do so by moving the Timeline time to get the position you want to 

sample and then insert the keyframe anywhere because Animator and Timeline have separate 

times. 

The red line marks the current time in Animator. This is the time where the keyframes will 

be inserted. 



   

 

 

1. Any changes using the widgets (movement, rotation, scaling) will automatically add that 

component to the clip and adds a key at the current moment (under the scrubber). If they 

exist already, they are updated. 

 

Here we see we have keys for the position and rotation. Scale and visibility are untouched. 

2. The transform values can be used to change/insert keys for any component that is active. 

The color of the fields changes to yellow to indicate that the field is active for animating. 

In the example below the translation and rotation components are keyed, but not the scale. 

Changes to non-animating fields (scale below) change the base value, not as a keyed value. 

 

3. Components (position, rotation, scale, visible) can be activated for a specific clip by right 

clicking on the row and selecting Animate. Alternatively, Set Key will animate it and also 

set the current state as the local keyed values. 

4. Keys can be added under the scrubber by pressing the K key when the focus is in the 

Animator window. 

5. Keys can be moved by dragging the dots. The dot in the gray row, moves all the keys for 

that component at once. 



   

 

 

6. Keys can be deleted by context clicking on the dots and selecting Delete. Using the dot in 

the gray row will delete all the keys for the component. 

1. clearing all the components will remove a keyed time completely 

 

Animation import 
Models formats that support animation import (such as .fbx) also automatically add these 

animations into Misterine Studio. Currently, we only support per-node animations so skeletal 

animations will not be imported. All successfully imported animation will be displayed in the 

Animator. Each animation will be in a track with a keyframe clip. The keyframe clip represents 

the keyframe data from the imported animation. 

Per-node animation 

Per-node animation is an animation where we animate the whole object or rather the node that the 

object is under. We basically save several transformations in time and interpolate between them. 

 

 

Note Editor 
Note editor can be accessed from the Scene Designer by selecting the Note to be edited and then 

either switching to the Note Editor in the viewport or by pressing the Edit button in the Property 

Editor.  

 

   
 

Note editor view consists of three main parts: Toolbox, Toolbar and Editor. 



   

 

 

 
 

The Toolbar contains a set of tools that can be used to manage the note viewport. Depending on 

the selected item the toolbar may contain more or less controls. This panel includes buttons for 

Undo/Redo operations, Zooming and Canvas Settings. If a node in the note is selected, 

operations for setting the Translation and Size values are available, as well as operations for 

ordering of overlapping nodes. 

 

The Toolbox contains a set of Nodes that are available for use inside the editor. To add them, just 

drag and drop them to the editor panel. Alternatively users can click the node and click again in 

the editor panel to add as many instances of the node as needed. Press Esc or Right-click to 

cancel the operation. 

 

Nodes added to the Editor panel can be moved by clicking and dragging the mouse, resized by 

clicking and dragging on the resize border and deleted from the context menu or by pressing the 

Delete key. 

 

Currently there are two nodes that can be added to the Note: 

 

Text Node 

 
As the name suggests, the Text node can contain formatted text. To input text into the node just 

click the inside of the node and start typing. When the Text node is selected, an additional 

toolbar is displayed above the node. This contains controls related to the node itself, in this case 

formatting options for the input text. 

 



   

 

 

Image Node 

 
Image nodes can contain images. These are loaded from project resources. Users can specify the 

behavior of the image inside this node for when the node is resized. Access these options by 

bringing up the context menu by right clicking on the node and choosing the option. 

 

 
 

 

Process Frontmatter/Metadata 
Processes can include lots of supporting information that is not directly part of the text of tasks. 

This information may be referenced in the text or extra information for the user. Additionally, we 

can add global Safety Requirements and Pre and Post Conditions which should be met when 

performing this Process.  

When opening a Process or clicking on the background of the diagram area, you will get access to 

the frontmatter details of the Process. This information is organized into different types. 

 
Process Overview 
Title: This is the title of the Process and what will be shown to the user in the Misterine App. This 

should generally be short. 

Description: This is presented with the title in the Misterine App to help the user understand more 

what the Process does. This may be a longer text, but still remain concise.  

Issue Date: When this version of the Process was released. In the case of S1000D this is the issue 

date of the original manual (DM) 

Original document: You can add an original manual in traditional document layout to the Process 

as a backup for the user. This can be either a website (URL) or a PDF. If specifying a PDF, it must 



   

 

 

be a resource in the Project. Also, you may want to set the PDF resources sharable access rights, 

if you want the Misterine App user to only be able to view rather than download the PDF. 

Language: This setting has no effect at the moment. It is intended for use in Misterine Studio 

editor in the future, for example for spell checking. Is set from S1000D. 

Country: This setting has no effect at the moment. Is set from S1000D. 

 

 

 

Process Codes 

Multiple QR codes and Barcodes can be created to achieve easier finding of the Process in 

Misterine App. With those additional identifiers specified the specific Process can be found by 

scanning a code from a physical object (for example from the box) related to the Process.  

The number of Process Codes is unlimited, but codes must be unique within a group of a single 

type. Also based on the type every code has to be in a specific format. 

The format of QR Codes is an unlimitedly long text where characters are from ISO-8859-1 

character set. Example: Process 12345/54321  

The format of Barcodes is an unlimited number of groups separated by a single space. Every group 

can contain an unlimited number of alphanumeric characters. Example: abc123 def456 ghi789 

 
 

Safety Requirements 
Global Safety requirements can be specified here. These affect the entire Process. The user will be 

presented with these before starting the actual tasks of the Process. There are three types of 

notifications defined. The order of presentation is strictly following this ordering. 

Warnings: This is the highest level. These will be presented with a red border. The Misterine App 

user must acknowledge the warning before they can continue.  

Cautions: These are displayed with a yellow border. They are informative for safety. The 

Misterine App user must acknowledge the caution, but they are easier to dismiss.  

Notes: These are purely informative. The Misterine App user can skip through these. They are 

displayed with a gray border. 

 

 

Figures 
Figures are the diagrams and images presented in traditional print (and web) versions of manuals. 

A figure consists of a Title and one or more images. Figures are referenced in the text.  

Equipment, Spares, Supplies 



   

 

 

These are any tools, parts, or disposables that the user may require to perform the task. These 

follow the S1000D standards definition, but with some extensions. Most notable it is possible to 

add an image in addition to the specification.  

At a minimum, at least a Title or Shortname must be specified. In addition, a Specification should 

be added. Specifications can be created in several ways depending on the sourcing of materials 

and the target group. There are four specification types, derived from S1000D: 

● Ident Number: Simple specification method specifying, Manufacturer Name, Serial # and 

Part #. 

● NATO Stock Number: Useful in contexts where the NATO stock numbers are used, such 

as military and other governmental agencies. 

● Tool Reference: Manufacturer Name and a tool number. 

● Catalog Sequence Number: (Supplies only) Consists of an Item and Figure Number and 

external reference to the catalog  

Pre-Conditions & Post-Conditions 
Pre and Post Conditions specify what the situation should be before and after the Process is 

executed respectively. This information is displayed to the user in Misterine App, but is not 

mandatory. They can skip this information.  

Both have the same specification: a description and an external reference. A reference is not 

required. 

Reference Table 
A table is generated which collects all external references found in the Process. They cannot be 

created directly here, but they can be edited here. The user in the Misterine App will have access 

to a table of references in the frontmatter. 

External References exist in three forms in this table. References to other Processes, incomplete 

references to other Processes, and URLs. Incomplete references to Processes occur on import of 

S1000D if the referenced DM has not yet been included in the Project. These are marked with a 

red dot. Importing the referenced DM later will automatically complete the references. 

 
External references shown in the table include all references. In addition, the same reference target 

(e.g. a URL) may be described differently in the text of the hyperlink of the task descriptions. We 

keep track of this and display it here. If there are different hyperlink texts, a foldout will show all 

variations. We see this with an URL in the example above. 

 

Working with Rich Text 
The Misterine Studio supports rich text markup for many text fields. The description of tasks 

includes all markup. The bar looks like this: 

 
The first section seen includes standard markup of text: bold, italics, underline, subscript, 

superscript and color.  

The second section includes layouting options in this order: 

● Bullet lists 



   

 

 

● Numbered lists 

● Definition lists - these are pseudo tables that more precisely do what we are writing here. 

There is a term (definition list) and a description of that term. 

● Tables - full width tables 

● Notes - notes are boxes that are inserted below the current paragraph and boxed. These are 

informative and used as side notes.  

● Text justification - this works also within table cells 

The third section defines Acronyms. The  button will insert a new acronym on the spot where 

the cursor is. The  button enables management of acronyms. Acronyms are controlled globally 

to a Process.  

The fourth section defines footnotes. As with Acronyms, footnotes are controlled at the Process 

level. The  inserts a new footnote. The  button inserts a footnote reference for an existing 

footnote at the current position. The  button opens an interface for the management of 

footnotes, including editing of the footnote text. 

The final section is for (hyper) links. A new link can be added with the  button. This button is 

not visible when cursor of the rich text editing area is within already created link. Instead of it the 

 button is shown. Purpose of this button is to remove a link under the cursor. Links can be 

edited and managed by opening a context menu of specific link to manage and selecting Manage 

reference option.  

 
When adding a link, a popup will show up to enable finding the proper reference. 



   

 

 

 
Link Reference Types 
Internal References: These are references to Spares, Equipment, Supplies, Figures, and Tables. 

Tables are found in the text of the same task or other tasks. In the Misterine App, Spares, 

Equipment and Supplies will show a tooltip with basic information to the user in place. Figures 

will open the images for viewing. Tables will open an overview with the table shown in the context 

of the text of the task. 

Process Reference: this is a reference to another Process. In the Misterine App, these links lead 

the user to complete the Process within the current Process. In the image in the previous section, 

we see a list of available Processes that can be chosen from.  

External References: These are references to external sources, such as URLs or other reference 

materials the user will be aware of. In the Misterine App, URLs are opened in a device native 

browser. 

Cross reference to internal Task: These links, when clicked, provide a form of jump to another 

task in the same Process. If possible, it is suggested that the Decision Point be used instead of this 

method.  

Autolinking Assistance Tool 
While writing text if you know some information about the target of a link that you would add 

with the tool described above, you can use our intellisense-like tool to complete this task quicker. 

While typing you can press the CTRL + SPACE key combination. A context menu will show up 

with suggestions for links that match your current text under the cursor. You can use arrow keys 

to select a link target and automatically create the link. 

 

 

 



   

 

 

Searching 

Misterine Studio supports the ability to search certain text inside a project. Use the menu item 

‘Search’ to open a modal search window. This window can be pinned to any panel side of the 

Studio. 

 

The search can be conducted using three regimes: ‘Match case’, ‘Match whole word’ and ‘Use 

regular expression’. The regimes can be combined, for example a search can run with ‘Match case’ 

and ‘Use regular expression’ regimes turned on. If no regime is selected, then the search tries to 

find words in case insensitive mode and matching parts of words or the whole words.  

 

The searching goes through all text properties of the process, process elements and resources. The 

results of the searching are presented as a tree, where the topmost parent is a process or resources 

and the bottom most child is a text property with a highlighted found word. 

  



   

 

 

The bottom most child element in the search tree has the arrow button. Clicking on that button user 

will be navigated to an element where the specified text was found. 

Searching can be conducted with the regular expressions. User should toggle the button and type 

the regular expression in the searching field. For example, the regular expression [0-9]{2} means 

that the text must contain two digits from zero to nine. It was not specified that there must be 

exactly two digits that is why the search found text that contains more than two digits in a row. 

  

To specify the restriction on the digits count the user should toggle the button and run the search 

again. 

  



   

 

 

If a user tries to use a wrong regular expression an error message “Regular expression is incorrect” 

will be shown. 

Process Validation 
Processes are validated continuously for completeness. Two levels of issues are identified: 

warnings and errors. Errors must be fixed. Warnings are very likely mistakes that should be 

corrected, but could be allowed in special cases. A red circular icon with an exclamation point is 

used for Processes with errors present. A yellow triangle is used for warnings. We validate: 

● Process flow (graph) is valid, meaning there is path from start to finish without any dead 

ends. 

● Process flow nodes (Presentation task, Decision points, Sub-process) are fully defined 

● 3D scene, if present, contains tracking information and at least one augmentation 

● Metadata information must be minimally complete  

The validation state is shown in multiple places at various levels of detail. 

The current state of all Processes is shown in the Project Explorer on the icon of the Process.  

 
The open Process (the diagram is showing) status is shown on the left-hand side of the lower status 

bar. Clicking on this image will open the Validation tab that is docked on the right side of the 

Process Flow (diagram) editor.  

 
The Validation tab in the closed state is shown to the left below. The open tab is show on the right. 

The  button can be used to keep it open.  

 
In the Validation tab, we can filter by Warnings and Errors. We can also click on the individual 

issues to be taken to the issue spot and have the problem highlighted.  

Finally, before deployment, the validation state is checked. If any issues exist, a popup will appear. 

In the following example, we see six Warnings and two Errors are present. It is not possible to 

deploy a Process with errors. A Process with only errors may be deployed.  



   

 

 

 

Process Deployment 
A Process deployment is the final phase of a Process creation. It is possible to deploy a package 

locally on the embedded server or remotely on the application server.  

 

The option to deploy can be found in a Process context menu or in the application menu Process 
→ Deploy Process to Embedded Server / Deploy Process to Server. 
 

 



   

 

 

 
When any Deploy option from the context menu is clicked the deployment dialog is shown with 

the first page containing information about the embedded server or the remote server. 

 

Storage Settings 
Storage settings form differs based on an option chosen by the context menu or application menu.  

 

For embedded server deployment the form displays the information that the package will be 

deployed to the embedded server. If the PC has multiple Network Interface Cards (NICs) the server 

will be running on all available IP addresses. The default port for embedded server is 57002.  

Embedded server is starting after the Next button is clicked. The deployed package will be 

available until the progress dialog is closed. 

 

 
 

Embedded server connectivity issues 

If the QR code is read by the Misterine App and you get a message “Specified Server not found”, 

please follow these steps: 



   

 

 

1. Make sure our phone or tablet is connected to the same local network as your desktop 

computer running the Misterine Studio. Typically, in a home or business environment, this 

should be case. Some companies may have multiple Wi-Fi networks, one for guests, others 

for employees. Make sure you use the proper one; ask your IT department if you are not 

sure. 

2. Make sure the embedded server is running. Any time this step of the deployment wizard 

dialog is visible the embedded server is running. Closing this dialog also shuts down the 

server. 

 

3. If you see multiple QR codes on the last sept of the deployment wizard, there are multiple 

active network cards connected to your computer. Some may be physical, some virtual, 

like the VPN. Usually, your mobile device will be connected to only one of these networks. 

If you don’t know which network is correct, you can try reading each until you find the 

right network. 

4. If your desktop computer is connected to a VPN, make sure the mobile device is also 

connected to the same VPN. 

5. Connection to the desktop computer may also blocked by windows firewall. You should 

enable the connection when the embedded server is run for the first time. The following 

window will appear: 



   

 

 

 

Click the domain (if available) and the private networks checkbox and then the Allow 

access button. 

6.  It may happen, that the Misterine Studio will not find any network interface for running 

the embedded server. If so, please make sure you have at least one network card (cable, 

Wi-Fi) active and connected. 

7. The access to the embedded server from the Misterine Application may be also blocked by 

your company firewall or a third-party firewall installed on your computer. Such firewalls 

may be installed as a part of anti-virus protection. Please, consult with an IT specialist on 

how to set such a firewall with Misterine Studio. The firewall may be also a part of your 

IT infrastructure. In this case, consult the situation with your company IT specialist. As a 

workaround you can run a hotspot on your mobile device. This will work if your desktop 

computer may connect to the ad-hoc network of your phone/tablet. In such a case the local 

network will be considered a “Public” one and you need to setup your firewall to allow 

incoming network on the Public interface to the Misterine Studio (see point 5). 

8. In very rare cases the Misterine Studio may not find any server port available for running 

the embedded server. By default, it tries to run on port 57002. If this one is already in use 

by another application, it will try the next port 57003. If this one is also occupied, it will 

continue trying 100 ports in the row till 57102. If all of them are occupied, an error will be 

shown informing that the server could not run. If an available free port is found, you may 

be prompted for rights to open it via the same dialog as in point 5. Please, click the domain 

and private networks, if available and then the Allow access button. 

 

For application server deployment the form informs about current Server status and allows to 

choose a visibility for deployed package.  

 

The Server address is the same address set in Edit → Preferences → Deployment. The form checks 

if the Server is prepared for a deployment. In case of issues error messages are listed in tooltip of 

 icon that appears next to the Online/Offline state.  

 



   

 

 

It is possible to directly open Preferences dialog with the Server address. However, the deployment 

process will be cancelled and after wanted changes in the Preferences dialog it must be run again 

from the beginning. 

 

 
 

A package visibility to can be set to either Public or Private. Public visibility means, that even 

anonymous (not logged) users of Misterine App can find and download that package. Private 

packages are only for logged users. 

 

Deployment 
The last page contains summary with all information about package to be deployed. By clicking 

the Deploy button, building and deploying of a package will start and a dialog informing about 

progress will appear. 

 

 
 



   

 

 

When the deployment is finished the progress dialog will display the QR-Code. This code can be 

used in the Misterine App to access the deployed package.  

 

 
 

It is possible to copy the generated link as a text or save the QR-Code as an image. 

Export 
When Process is completed, some parts of it can be easily exported to different formats for further 

usage. 

 

Export of a Process to HTML 
Except deploying a Process in a form of package, there is also a possibility to export it to HTML 

document. The purpose of this document is to offer an overview of values (name, description, 

steps, figures etc.) set during a Process creation. The document can be also printed out and can be 

used without any electronic device. Export to HTML document can be done by using Project → 
Export → Export Process to HTML with one Process selected in Project Explorer or by using a 

context menu option Export to HTML of a Process you want to export. 

 

 



   

 

 

 
 

The only limitation of this feature is excluding Scenes (models, animations etc.) from the 

document because the Scenes are used for augmented reality which is not possible in HTML 

format. 

 

When a Process is exported to the HTML document, the default CSS (Cascading Style Sheets) is 

applied. For those who are familiar with this kind of styling you can see a content of the default 

CSS in Preferences → Export → HTML export.  
 

 
 

A CSS can be freely changed, but take in mind, only classes defined in the default CSS can be 

used. Any other classes are ignored. It is recommended to take the default CSS and modify it to 

achieve desired result. 

 



   

 

 

The result of the export is following structure: 

 

● {name of the Project} – Root folder of the exported Process 

o icons – Folder containing all supporting icon images used in HTML document 

o images – Folder containing all images used in the Process by a user (f.e. figures) 

o {title of the Process}.html – Final HTML file 

 

Export of Tracking Markers to PDF 
For using an augmented reality in Misterine App you have to have Tracking Markers used in 

Misterine Studio printed out. For this purpose, an option for generating a PDF file containing 

Tracking Markers is accessible by using Project → Export → Export Markers to PDF or by using a 

context menu option Generate Tracking Document of a Process you want to print out Tracking 

Markers for.  

 

 
The final PDF document contains all Tracking Markers used in all Scenes of a selected Process in 

Project Explorer. After generating the PDF document is immediately opened in an application 

assigned for opening PDF files by an operation system. 

 

A1) S1000D Limitations 
Lists (Random/Sequential/AttentionRandom/AttentionSequential) 

● A list item is limited to one para element 



   

 

 

● List types has to be the same on the same level. 

● Only simple numbering is supported (nested lists start again from 1) 

● Titles are not supported 

Styles 
● Emphasis can be converted to character styles (bold, italic, ...) when parsing from S1000D. 

Information about emphasis in not being kept from that point forward in the deployment 

process. 

Links 
● Internal reference to anything other than steps, figures, supplies, equipment, spares, & 

Tables 

Tables 
● Tables cannot be embedded in tables 

● We do not support cell rotation 

● We support only % column spacing 

● Groups are not supported 

● The widths of columns are supported for the whole table, not individual rows 

● Tables cannot have margins 

● Tables inside lists cannot have indentation 

● We do not support tgstyle tag for Busines Rules and standard table types (see BRDP-S1-

00121) 

● Vertical justification not supported 

● Support for irregular tables is limited 

● Warnings and Cautions are not supported 

Rich Text 
● Acronyms: we do not support bullet points inside of acronyms 

● Acronyms: we do not support rich text (superscript, subscript) in acronym search 

● Inline images are not supported 

 

 

A2) General Limitations 
Lists 

● A list item is limited to one para element 

● List types have to be the same on the same level. 

● Indenting list, while the cursor is on the first item, causes indentation for the whole list, not 

a level shift 

● Only simple numbering is supported (nested lists start again from 1) 

● Deleting the first item in lists will cause inconsistent numbering 

● It is possible to create scattered lists (lists interrupted by text) but they will be unscattered 

in the next session 

● Titles are not supported 

Tables 
Table structure 

● We do not support cell rotation 

● We support only % column spacing 

● The widths of columns are supported for the whole table, not individual rows 



   

 

 

● Support for irregular tables is limited (irregular tables are turned into rectangular ones) 

 

Table placement 

● Tables cannot have margins 

● Tables inside lists cannot have an indentation 

● Tables inserted as first list item will be added before the list 

Table selection 

● Multiple cell selection and typing behavior is inconsistent (when selectin from bottom-up 

/ from top to bottom) 

● Column selection causes scrolling 

Table behavior 

● Pressing enter at the beginning of the very first cell causes a new line to appear above the 

table 

● Manually set row height is not preserved 

● Tables created inside lists will inherit lists in all its cells 

● Tables created inside lists split the list and add another empty item 

● Pressing TAB creates in the last cell creates a new row with the same options (formatting 

and lists, etc.) 

Table Copy & Paste 

● Cut and pasted tables that are being referenced will lose the reference 

Scrolling 
● Horizontal scrollbar is displayed even when content decreases in width 

● Horizontal is only displayed when Vertical scrollbar is at the very bottom 

Hyperlinks 
● Links appear to have format applied to them, but it is lost in next session 

Selection 
● Selecting a format that changes caret style (italic) and navigating elsewhere does not clear 

the style 

3D Models 
● Limit of 41.5 million triangles on a single mesh on import 

● Max size of a scene for deployment to the newest generation of iPad is ~4.5 million 

triangles.  

 

A3) Keyboard Shortcuts 
Sections below describe controls, shortcuts and hints for using different parts of Misterine 

Studio. 

 

Project  
Project Explorer 

UP Select project item below the last selected project item 

DOWN Select project item above the last selected project item 

SPACE Expand / Collapse folder 

DELETE Delete selection 

CTRL + C Copy project item (only for Process) 

CTRL + V Paste project item (only for Process) 



   

 

 

CTRL + D Duplicate project item (only for Process) 

RMB Open context menu 

LMB select Select project item in the tree 

CTRL + LMB Add a project item to a selection 

Process  
Process Editor 

CTRL + C Copy current selection 

CTRL + V Paste copied selection on a mouse position or on a position of a source 

with an offset (if mouse is not over edit area) 

CTRL + D Duplicate current selection 

DELETE Delete current selection 

CTRL+Z Undo 

CTRL+Y Redo 

ESC or RMB Cancel node creating action if it’s in progress 

RMB Open context menu for selected object(s) 

LMB Select object / Deselect all objects if not clicked on object 

CTRL + LMB Add object to current selection 

LMB + Drag ● Start creation of a connection (Output anchor point) 

● Change endpoint of a connection (Connection start or end)  

● Move (Node) 

● Box selection (none) 

Double LMB Open scene (only for Presentation Task) 

Mouse wheel Zoom in / out 

Toolbox 

LMB / RMB ● Expand / Collapse (Toolbox group) 

● Select / Deselect (Toolbox item) = Start / End node creation 

action using click’n click (click on Toolbox item, click on 

Process Flow edit area) 

LMB + Drag Start node creation action using drag’n drop (drag Toolbox item, drop 

on Process Flow edit) 

Validation 

UP Select validation item above currently selected validation item 

DOWN Select validation item below currently selected validation item 

ENTER / Double 

LMB 

Navigate to a place relative to selected validation item 

LMB / RMB Select a validation item in the list 

Rich Text Editor 

CTRL + B Make text bold 

CTRL + I Make text italic 

CTRL + U Make text underlined 

CTRL + = Make text subscripted 

CTRL + SHIFT + = Make text superscripted 

CTRL + SPACE Open popup with suggestions 

UP Move to a suggestion above currently selected suggestion (only 

Suggestions popup) 



   

 

 

DOWN Move to a suggestion below currently selected suggestion (only 

Suggestions popup) 

ENTER Confirm currently selected suggestion (only Suggestions popup) 

Scene 
Scene Editor   

CTRL + F Focus the search field (type in and press Enter to search) 

CTRL + I Import a model 

CTRL + Z Undo 

CTRL + Y Redo 

CTRL + 1 Add a tracking marker 

CTRL + 2 Add an interactive anchor 

CTRL + 3 Add a label to the selection 

CTRL + 4 Add a note 

ALT + M Show / Hide radial menu 

ALT + C Move the selection to origin 

CTRL + H Hide selected 

CTRL + SHIFT + H Show selected 

CTRL + SHIFT + I Inverse selection 

Q Select tool 

W Translate tool 

E Rotate tool 

R Scale tool 

T Snapping tool 

Y Move label line start position 

F Focus on selection (focus all if nothing is selected) 

DELETE Delete selected object (if in a text field, it works on the text inside) 

CTRL + A Select all 

CTRL + SHIFT + A Select all that is visible (the selection is stopped by first invisible node) 

CTRL + D Deselect all 

CTRL + V Insert a model (only if an object file in Windows Explorer is selected 

and copied before) 

LMB Select object in the scene / Deselect all 

CTRL + LMB Toggle selection 

SHIFT + LMB Add to selection 

ALT + LMB Select common parent of the current selection when clicked on 

RMB Rotate around a target (displayed as a small red sphere). If the mouse is 

over an object, the target is the 3D point under the mouse cursor. While 

rotating, the red sphere is connected to its projection to XZ plane with 

yellow line.  

Shift + LMB + 

Vertical mouse 

movement 

Zoom to an object under the mouse (if any), or to the target (red 

sphere) 

Mouse wheel Zoom to center 

RMB + Mouse 

wheel 

Zoom to the center of rotation 



   

 

 

CTRL + Space Toggle between multi-view layout and single-view layout 

Scene Explorer 

LMB Select object in the tree / Deselect all 

RMB Open context menu 

CTRL + RIGHT Move the horizontal scrollbar to the right 

CTRL + LEFT Move the horizontal scrollbar to the left 

SHIFT+SCROLL Move the horizontal scrollbar 

CTRL + UP Move the focus up 

CTRL + DOWN Move the focus down 

SHIFT+UP/DOWN 
Add to selection when moving from focused object. Removes from 

selection when going back. 

RIGHT Expand an assembly 

LEFT Collapse an assembly 

UP Select the node up from the current one 

DOWN Select the node down from the current one 

CTRL+SPACE Select / Deselect focused object. 

CTRL+ENTER Select / Deselect focused object. 

HOME Select the first object in the tree 

END Select the last object in the tree 

CTRL+HOME Focus the first object in the tree 

CTRL+END Focus the last object in the tree 

SHIFT+HOME Select all between last selected and top of the tree 

SHIFT+END Select all between last selected and end of the tree 

 

Filtering in Scene Explorer 

 

Scene Explorer offers basic filtering of items based on their name, or special filters for more 

restrictive filtering. All possible filters are listed in a table below. 

 

:m {VALUE} Filters meshes with name containing {VALUE} 

:nm {VALUE} Filters non-meshes with name containing {VALUE} 

:tm {VALUE} Filters tracking markers with name containing {VALUE} 

:ia {VALUE} Filters interactive anchors with name containing {VALUE} 

:l {VALUE} Filters labels with name containing {VALUE} 

:a {VALUE} Filters nodes with animations with name containing {VALUE} 

:ma {VALUE} Filters nodes with materials with name containing {VALUE} 

:n {VALUE} Filters notes with name containing {VALUE} 

:{KEY} {VALUE} Filters nodes with property key containing {KEY} and with property 

value containing {VALUE} (only for models imported from JT file) 

● if {VALUE} is unspecified, the related restriction is ignored 

Examples  

:tm filters all Tracking Markers 

:tm Marker1 filters all Tracking Markers with name containing Marker1 

:number filters all items with property key containing number  



   

 

 

:number 123 filters all items with property key containing number and with property value 

containing 123 

Animator 

G Regenerate the keyframes (if keyframe generator is active) 

K Create keyframe at current time 

C Set the time to current time (Clip start/end time input field must be 

focused)  

Timeline 

RMB Open a context menu 

CTRL + SHIFT + C Copy the clip (The clip must be selected. The clip is serialized to JSON 

format)  

CTRL + C Copy the selected clip 

CTRL + V Paste the content of clipboard to highlighted track at current time – can 

be, for example, a selected clip (if the clipboard content is incompatible 

to paste, nothing happens)  

CTRL + Drag Duplicate and move the clip 

ALT + Drag Move the clip between tracks 

SHIFT + Drag Snap the clip to clip endpoints, 0, and current time 

History 

HOME Focus on the first object in the history 

END Focus on the last object in the history 

UP Focus on node up from the top 

DOWN Focus on node down from the top 

SPACE Move to this point in history 

 


